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Tuesday 
April 26, 2010 
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April 12, 2011 

Monthly Meetings Held At Gould Auditorium 
2nd Floor, St. Joseph Community Center, Lorain, OH  

5:30 PM Doors Open With Q & A Sessions 
Meeting & Presentation Begin Between 7:00 & 7:15 PM 

Social Networking 
 

Presented by 

 

Sandee Ruth 
President 

&  

Richard Barnett 
Web Page Editor 

 

      Plum Brook Facility Tour 
5-7PM in Sandusky 

Reservations required 

by April 18th 

Presented by 

 Stephanie Snider 

http://www.LCCUG.com
mailto:info@LCCUG.com


April 2011|  Interface Volume 23 Issue 4| Page  2 

LCCUG Off icer s For 2011 A Word From 

Our President 
President 

Sandee Ruth 
president@lccug.com 

Vice President 
Lou Koch & Carole Doerr 
vp-programs@lccug.com 

Secretary 
Don Hall 

secretary@lccug.com 

Treasurer 
Micky Knickman 

treasurer@lccug.com 

Newsletter 

Editor 

Pam Rihel 
newsletter@lccug.com 

Web Page Editor 
Richard Barnett 

webpage@lccug.com 

Statutory Agent 
Sandra Ruth 

statutory_agent@lccug.com 

Director of 

Membership 

Dennis Smith 
membership@lccug.com 

Director of 

Advertising 

Richard Barnett  
advertising@lccug.com 

Director of  

Public Relations 

Carole Doerr 
public_relations@lccug.com 

Director of  

Education 

Kaye Coller 
education@lccug.com 

During our April 12 LCCUG meeting we will be looking 
at Social media – particularly LinkedIn, Twitter, and Fa-
cebook. It seems that everywhere you look in print and 
online there are invitations to follow someone or some-
thing on Facebook or Twitter.  For businesses it can be 
a way to spread word about their services without a big 
PR budget.  I know many members are still wondering 
what all the fuss is about. 
 
The Internet has become a living and an ever-changing 
entity.  It is not something you go to and read what is 
written.  It is now something we participate in, using the-
se Social Media tools and many, many others.  
Because Twitter can be used with ease on both PCs 
and mobile devices and because it limits users to very 
short messages of 140 characters or less, it has be-
come one of the largest platforms in the world for shar-
ing real-time data. A number of large businesses and 
celebrities have hundreds of thousands of followers on 
Twitter.** 
 
And there is Facebook, which is enormous.  How big is 
Facebook?  If it were a country it would be the third larg-
est.  Social media has taken over Porn as the #1 online 
activity.  I found it interesting to note that the fastest 
growing segments of new users on Facebook are 44-65 
year old females!  That is probably because the younger 
generation is already there.   
 
In the case of LinkedIn, it is reported that 80% of the 
companies use social media for recruitment of new em-
ployees and 95% of those are on LinkedIn. 
I was fascinated to read how important Social media 
was in the aftermath of the Japanese earthquake and 
tsunami.  Mobile phone networks and some telephone 
landlines collapsed in the hours following the 8.9 scale 
earthquake.  Websites, powered by broadband connec-
tions, became a lifeline for many of those in Japan. 
For many, Twitter, the micro blogging site and Face-
book, have become the easiest, quickest and most relia-
ble way for the survivors to keep in touch with relatives 
as well as providing emergency numbers and infor-
mation to those in stricken areas. 
 
Even the US State Department resorted to using Twitter 
to publish emergency numbers, and informing Japanese 
residents in America how to contact families back in 
Asia. Relief organizations used Twitter to post infor-
mation for non-Japanese speakers and lists of shelters 
for those left homeless. 
 
Skype, the phone service that operates over the inter-
net, and Google, the information website, also became 

invaluable resources for those searching for missing 
relatives.  
 
Many mobile phone networks are unable to cope in the 
immediate aftermath of a crisis if hundreds of thousands 
of customers try to make a call or send a text at the 
same time, as many Londoners discovered during the 
July 2007 terrorist incidents. 
 
Even though it is not actually social media, I thought it 
was interesting that even the MagicJack phone was a 
useable tool during the disaster.  One Cleveland student 
reported that they had a MagicJack phone connection in 
their Japanese home.  Because it uses the internet for 
connectivity, it continued to work when other local con-
nections did not. 
 
I hope you will be able to attend our next presentation 
and learn more about this important phenomenon. 
 

     Sandee 
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TUESDAY 

April 12, 2011 

TUESDAY 

April 26, 2011 

Plum Brook  
Facility Tour 

Presented by 

 Stephanie Snider 
5-7 PM in Sandusky 

Email your reservation by April 18th to 
vp-programs@lccug.com 

Social Networking  
 

Presented by 
 

Sandee Ruth 

&  

Richard Barnett 

If you have ever wondered where to go 

on the internet to socialize or contact 

people on topics that you are interested 

in - here's where you will find clues. 
 

Tonight's presentation will focus on the major Social Net-

working web sites such as Facebook, MySpace, Twitter, 

LinkedIn, etc. and the changes that have taken place since 

these sites were first conceived.  We will additionally talk 

about some "not so major but equally fun and useful sites 

such as, Foursquare, Biznik, and others.  This relatively new 

Internet phenomena is taking the world by a "social storm", so 

to speak.  We hope to unravel some of the mysteries of these 

sites for you. 

 

It will be a fascinating  and interesting evening for all. 

We have the opportunity to tour the NASA Plum Brook facil-

ity in Sandusky.  How many of us even knew there was a 

NASA facility in Sandusky?   

 

This facility does a variety of testing including the Space 

Power Facility which is the home of the world's largest space 

environment simulation chamber.  The facility has tested parts 

of rockets, Mars landers and space stations.  

 

As a Spacecraft Propulsion Research Facility, this is the 

world's only test facility capable of full-scale rocket engine 

firings and launch vehicle system level testing’s at high alti-

tude conditions, just to name a few functions at this location.    

 

      Cryogenic Propellant Tank Facility (K-Site) is a smaller 

space-environment test chamber allows safe, large-scale ex-

periments using super-cold liquid hydrogen. Together with 

the CCL facility, these facilities compose the Cryogenic Test 

Complex. 

 

   Their Cryogenic Components Laboratory (CCL) is a new, 

state-of-the-art facility for research, development and qualifi-

cation of cryogenic materials, components and systems. To-

gether with the K-Site facility, these facilities compose the 

Cryogenic Test Complex. 

 

    A Hypersonic Tunnel Facility (HTF) is a unique wind tun-

nel designed to test air-breathing propulsion systems at speeds 

exceeding 5 times the speed of sound.   

 

There will be question and answer periods throughout the 

tour.  

 

Because of security issues: 
We must turn in the names of attendees one week ahead of 

time.    

 

Carpooling is a must as we will be driving between buildings 

once we enter the facility and parking is limited at the test 

sites.  We will discuss carpooling among those who sign up to 

go. We will have to come in as few vehicles as possible.  

 

 

Everyone must have a picture ID to be presented upon entry 

and you must be over 18 years old.  

WIN A NEW HP 
LAPTOP! 

 

Laptop tickets are now being 
sold now for $5.00 each and they are going 
fast, as we only had 200 to sell. 
 

Hurry and purchase your tickets now.   
Drawing will be held, at one of our regular 

meetings, when all tickets are sold. 
 

If you took tickets to sell please return the 
ticket stubs and any monies you have col-
lected at our general meetings or contact 
Carole Doerr at:  

vp-programs@lccug.com 
 

We do need you to return any unsold tickets, 
so our ticket count can be verified. 

Good Luck All 

mailto:vp-programs@lccug.com
mailto:vp-programs@lccug.com
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 COMPUTER REPAIR 

 PRINTERS & SUPPLIES 

 UPGRADES 

* CUSTOM PC'S & LAPTOPS 

* CALL FOR BEST PRICES 

* EDUCATION DISCOUNTS 

 LCD MONITORS & TVS 

365-2288 - Elyria  1-800-238-8973 - USA  
 

591 Cleveland Street   Elyria, Ohio  44035 

Shop at    www.ROYALBUSINESS.com    and save $$$ 
 

Financing Available  -  90 days same as cash 

Executive Board  

Meeting Minutes 

General 

Meeting Minutes 

Newsletter Editor:  Pam Rihel using Microsoft Publisher, Corel 
Paint Shop Pro X3, CreataCard 8.  

 

This Month’s contributors: Micky Knickman, Sandra Ruth, Kaye 
Coller, Pam Rihel, Carole Doerr, Don Hall, Sandy Malitz, Joanna 
Clay, Rod Scher, Ian Wilsker, Joseph Moran, Trevor Meers, APCUG, 
Wordtips.net, Exceltips.net, Smart Computing Magazine, Microsoft 
Office art online, PC Computer Magazine, CPU, 
 

Newsletter is now 
Online 

at 
lccug.com/newsletters or lccug.com 

MARCH 1, 2011 
 

Attending were Sandee Ruth, Carole Doerr, Don Hall, 
Micky Knickman, Pam Rihel, Richard Barnett, Dennis 
Smith and Kaye Coller. 
 

Don will take a picture of the falcon, ―Havoc‖,  whom the 
club adopted at the LCMP  Raptor Center. 
 

Kaye will proof read the newsletter with Pam. 
 

Pam will write a memo in the newsletter advising 
members of our meeting cancellations policy. 
 

Carol reported 150 tickets have been sold out of 200 for 
our laptop computer raffle. 
 

After considerable discussion, it was agreed we will start 
the tips & help session at 6:45 using the big screen. 
 

Sandee was authorized to order 12 more mugs as gifts 
to our outside presenters. 
 

It was reported the membership appreciated the 
―Upcoming 2011 Programs‖ flyer mailed to them. We 
might continue to publish the flyer. 
 

Sandee will again mention the CERT, Homeland 
Security training at the next meeting. 
 

Notice of an upcoming meeting will be sent out on the 
Sunday preceding the meeting. 
 

Kaye will contact Jean with regard to what type of 
intermediate class she will be teaching. 
 

Sandee will contact Diane at the Senior Center on 
disposition of the computers we have there. 
 

The upcoming APCUG conference was discussed.  
 

Richard moved, Carole seconded the meeting be 
adjourned. 

MARCH 8, 2011 
 

President Sandee Ruth called the meeting to order. A 
motion to accept the minutes as shown in the March 
issue of the INTERFASE was made by Jesse Jasinto, 
seconded by Richard Long. 
 
Sandee told attendees about Pam’s upcoming genealo-
gy class, the APCUG Conference being held this sum-
mer and the raffle we are holding for a laptop computer. 
 
Captain Jim Drozdowski along with Jason Perkins, IT 
Director, and Mike Lopez, Forensics, of the Lorain 
County Sheriff’s Department presented a very interest-
ing and informative program covering identity theft, 
credit card theft, child porn and vehicle identification. 
The department has 7 sub-stations in the county, 41 
laptops in cruisers and a 440 bed jail. There were many 
questions from the attentive audience. 
 
Maggie Etzkorn was the big raffle winner tonight, win-
ning both the money raffle and the software/hardware 
raffles. Tom Shoup’s name was drawn for the attend-
ance raffle, however he was not present. 
 
Pam moved, John Dunn seconded that the meeting be 
adjourned. 

http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
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http://www.ROYALBUSINESS.com
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http://www.ROYALBUSINESS.com
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 Pam Rihel  LadyGeneo@roadrunner.com 

How To Be Successful At Doing Immigrant  

Research      Part 2 
 

Passports 
 

 General Information 

 Could receive one from c. 1790 - present 

 Passports were not required before mid 1950s 

except during WWI 

 Many naturalized citizens got them as protection 

when traveling in Europe, some countries re-

quired them. 

     Information - from early 20th century 

 Name, birthdates & place, residence, departure 

date & destination were listed. 

 Naturalized citizens had to provide proof of nat-

uralization, plus the date & court 

 Children of immigrants brought here as minors 

had to include father’s name & his date & place 

of birth. 

     Records - dates are not consecutive with the rec-

ords 

 1790 - 1925 applications   

 1790 - 1923 Indexed 

 1925 - through present somewhat restricted, 

available on loan through Family History Cen-

ters and possibly on Ancestry.com, Heritage 

Quest to name a few,  I am not sure about the 

websites, but if you belong to either of these 

sites you can check them out yourself. 

 1925 to present, somewhat restricted, Passport 

Office, Department of State, Washington DC., 

20520. 

 Check out your ancestor leaving for a visit to 

their home country, this may lead to their home 

village, and if your ancestor did not travel back 

maybe one of their siblings or children did. 
 

Miscellaneous 
 

     Alien Registration 

  Alien Registration Act (Smith Act) passed 

 June 28, 1940. 

  This required all non citizens age 14 years 

or older & living in the U. S. to register at their 

local Post Office or INS Office (Immigration & 

Naturalization Service, now USCIS or U. S. Citi-

zen & Immigration Service) 
  

 Beginning, June 1940, all immigrants arriving in 

the U. S. had to perform Alien Registration when 

they applied to immigrate.  This still applies to-

day. 
 

 Information may include: name, name used when 

entering U. S., other names, addresses, birth date, 

city, province, country of birth, citizen of which 

country, sex, race, marital status, physical de-

scription, port of entry, date of entry, vessel, im-

migration status (passenger, crew member, stow-

away, etc.), date of arrival, where they will live in 

U. S.,  or have lived in the U. S.  How many 

years, memberships or activities in clubs, organi-

zations, societies, military in country, branch, 

dates, parents, spouse, children in U. S., arrests, 

when they applied for citizenship or not, dates of 

1st and 2nd papers, occupation, employer, resi-

dence status (permanent, visitor, student, treaty 

merchant, seaman, official or employee of for-

eign government, involvement in political activi-

ties, public relations or putlic policy for a foreign 

government. 
 

 To get the record, make your request on the 

USCIS G-639 POIA form.  This can be found at 

www.uscis.gov.  Ask for the Alien Registration 

as well as any other record related to you’re an-

cestor.  Mail the FOIA form to U. S. Department 

of Homeland Security, 2nd Floor, FOIA Unit, 

111 Massachusetts Ave., NW, Washington, DC 

20529. 
 

 Include your ancestor’s death certificate if he was 

born less than 100 years ago, also include your 

purpose for the request - family genealogy. 
 

 Ask for a MANUAL search.  In 2 to 3 weeks, you 

should receive your receipt and USCIS FOIA 

case tracking number.  It may take several 

months before receiving a response to your re-

quest. 

 Passenger Arrival Announcement - newspapers 

 Abstracted Records i.e. In search of Missing 

Friends. 

 Fraternal Organizations 

 Immigrant Aid Societies 

 Ethnic Newspapers 

 Travel Agency Records 

 

Now You Are Ready To Trace Your Ancestor In 

European Records 
 

 BUT only if you know 

(Continued on page 6) 

mailto:LadyGeneo@roadrunner.com
http://www.uscis.gov
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  Name of town(s) where your ancestor lived 

 Must be name of town at the time you’re  

 ancestor lived there. 

 May be different from today’s name 

 European name may be different than the name 

 we use in the U. S.  

 The country in which the town was located 

when your ancestors were there. 

 Name(s) your ancestors used in Europe (if possi-

ble).  European spellings of your surname. 

  Other Helpful Information 

 To which (if any) ethnic minority they belonged.  

Were they displaced? 

 Religion of your ancestor. 

 Migration patterns within the country. 

 Who collected vital records.  When were vital 

records officially kept? 

 Wars, natural disasters, geography. 
 

   Problems  

Boundary Changes 

 Breakup of the Austro-Hungarian Empire 1918-

1919. 

 Dissolution of the Ottoman Empire 1830-1913. 

 Division of Germany & loss of eastern territory 

1946; reunification 1990. 

 Record Location - not consistent as in the U. S. 

 Destruction of Records, many due to wars. 
 

FHL Resources 

 Family History Library Catalog (FHLC) prov-

ince your town in which your town was located.  

Shows records which have been microfilmed. 

 Research Outlines 
 

Emigration Records 

 Passenger Lists, direct & indirect, Hamburg 

Passenger Lists 1850 - 1934 

 Police Lists 

 Passport Applications 

 Permission to Emigrate 
 

Other Records 

 Vital Records - birth marriage & death 

 Church Records i.e. baptisms, christening, mem-

bership 

 Military Records 
 

Resources 

 How-to-books 

 Translation Guides - most records will be in a 

(Continued from page 5) Genealogy 
 

foreign language  

  Following the Paper Trail by Jonathan Shea 

  Word lists - Family History Library 

  Foreign Language Dictionary 
 

 Maps 

 Foreign Language form letters which can be sent to a 

church or govt. agency. 

 LI-RA-MA COLLECTION - Russian consular records in 

the Public Archives of Canada. 
 

Includes people from Armenia, Estonia, Finland, Geor-

gia, Latvia, Lithuania, Poland, Russia, Ukraine, 2.  

Many eventually went to live with relatives in the U. S. 
 

Consulates in Montreal, Vancouver, and Halifax 
 

After Russian Revolution (1917) Canada did not recog-

nize new government.  After Canada recognized the 

new government in 1922, records were sent to Russian 

consulates in New York & Boston and later to the Rus-

sian Embassy in Washington and the U. S. National 

Archives.  Returned to Canada in 1980. 
 

For further information, write to the National Ethnic 

Archives of Canada, Manuscript Division, Public Ar-

chives of Canada, 395 Wellington St., Ottawa, Ontario 

KIA 0N3. 
 

Similar records are available at the Russian Consulates 

in the U. S. Boston, Chicago, Honolulu, New York, 

Portland, Philadelphia, San Francisco, Seattle. 
 

Records may include records of immigration, settle-

ment, military service in both Canada & Russia, educa-

tion, Russian police permits, details of place of origin, 

family histories, photographs, letter, certificates. 
 

 Record Location 

 Generally, not necessary to write to Europe. 

 Family History Library has filmed many records. 
 

 Websites: Emigrant Experience 

 Port of Hamburg  

 http://german.about.com/library/weekly/aa040300a.htm 
 

 Home Children & Young Immigrants to Canada: 

 www.dcs.uwaterloo.ca/~marj/genealogy/homeadd.html 
 

 Naturalization Records 

 Kings County Clerk’s Office (Brooklyn, NY) Index To 

 Naturalization Records 1907-1924: 

 www.jgsny.org/kingsintro1.htm 
 Cuyahoga Col, OH 

 www.rootsweb.com/~ohcuyah2 
 

Passenger Lists 

 Immigrant Shop Transcribers Guild 

 www.immigrantships.net 
 Olive Tree Genealogy-Passenger Lists 

 http://olivetreegenealogy.com/ships/index.shtml 

(Continued on page 7) 
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We are looking for teachers.  
 

Volunteer to teach something you know something 
about.  You don’t have to be a master of the subject; 
both teachers and students usually learn!  LCCC has a 
great computer lab at St. Joseph’s Community Center,  
that we are able to use.  You just have to call Dina and 
set up a time for your class and to let her know if she is 
taking the reservations or if you are.   
 

Kaye Coller 
Education Director  education@lccug.com 

 
 

Let one of the officers know so we can put it in the 
classes section of our newsletter and on our web pag-
es. 
 

Get involved with your club to make it better for every-
one. 

 Directory of Passenger Shop Arrivals: 

 www.daddezio.com/genealogy/ships/index.html 
 

Websites within this article have been checked and are in 

working order.    
 

Most of this information came from Sandy Malitz, volunteer 

at WRHS until she became ill and could no longer volunteer 

her services. 

(Continued from page 6) Genealogy 
 

SOFTWARE UPDATES 
  

COMPILED BY JOANNA CLAY 
 

PDFCreator 
Update: The 1.2.0 release of PDFCreator, free software 
that creates PDF (Portable Document Format) files from 
any printable program, fixes printing issues in certain 
applications and programs. The new version also sup-
ports transparent PNG files. PDFCreator can create oth-
er file formats, such as PNG, JPEG, TIFF, BMP, PCX, 
PS, and EPS. 
 

You can digitally sign PDFs to verify authentication, se-
cure them with encryption, and combine multiple files 
into a single PDF. 
 

Installation: To take advantage of the new PDFCreator 
features, go to www.pdfforge.org and click Download at 
the top of the home page.  Click Download PDFCreator 
1.2.0 on the first red PDFCreator button. The site will 
open a new window with the URL 
www.sourceforge.net; your file download should start 
in the browser momentarily. Click the PDFCreator EXE 
file, select Run, and follow the instructions to complete 
the download. 
 

Adobe Flash Player 
Update: Adobe Flash Player 10.2 is available. The up-
dated capabilities include Stage Video hardware accel-
eration for image rendering, Internet Explorer 9 support 
for hardware accelerated graphics, customized mouse 
cursors, and full-screen mode for multiple monitors. 
 

Installation: To get the update, visit get.adobe.com/
flashplayer. By default, the update will also install the 
Google Toolbar on your computer. If you’d rather not 
install the toolbar, uncheck the Include In Your Down-
load box and then click the Download Now button.  
When a yellow bar appears at the top of the page, click 
it and then click Install ActiveX Control. Click Continue if 
the UAC (User Account Control) message appears. Fi-
nally, click the Install button. 
 

AVG Anti-Virus Free Edition 2011 
Update: AVG’s latest 2011 version of its free security 
software is available for download. The updated edition 

provides basic protection against online threats using 
the AVG LinkScanner. AVG also safeguards your social 
networking activity with AVG Social Networking Protec-
tion. AVG Community Protection Network and AVG Pro-
tective Cloud Technology offer real-time virus infor-
mation, 
as well. 
 

Installation: When you visit www.free.avg.com, click 

Get Basic Protection next to the Homepage tab. Then, 

click the Download button under AVG Anti-Virus Free 

Edition 2011. On the next page, click Download again. 

You will be directed to the Cnet.com download page on 

which you will click Download Now. Lastly, click the EXE 

file, click Run, and complete the rest of the download 

instructions. 
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

http://www.loraincounty.com/
http://www.smartcomputing.com/
mailto:education@lccug.com
http://www.daddezio.com/genealogy/ships/index.html
http://www.sourceforge.net
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A Different Kind of  
Cloud Back-up 
 

As February drew to a close, approximately 150,000 
Gmail users found their accounts had been reset, with a 
glitch having wiped out their email messages and con-
tact information.  By early March, Google had restored 
many of the accounts, but heavy users remained affect-
ed for longer (and might still be waiting for their data).  
It’s this type of situation that Backupify 
(www.backupify.com) addresses with its automated 
backup service. 
 

Backupify is different from other cloud storage compa-
nies in that it offers a Web service for Web services.  
That is, it’s an online service that backs up information 
from Google Apps, Bacebook, and Zoho accounts, 
among others, via personal, business, and enterprise-
level accounts.  The company also snatched up Tweet-
Backup in November 2010, clearing out some competi-
tion and adding Twitter account backup toits offerings. 
 

Backupify, with headquarters in Cambridge, Mass., is 

currently still working with the $4.5 million in Series A 

funding it received in September 2010 in a round led by 

Avalon Ventures.  On the heels of the Gmail problem, 

it’s quite possible that additional funding for Backupify is 

just around the corner. 

 
 

A Window Manual To 
Make Use Of 
 

We’re always on the lookout for good resources we can 

direct our less tech-savvy friends and family to and less-

en the ―you’re a geek, so you must have all the an-

swers‖ burden we shoulder too often.  You’re probably 

in the same boat, hence the mention of 

MakeUseOf.com’s new ―Windows On Speed: Ultimate 

PC Acceleration Manual.‖  Available as a free PDF 

download or readable at Scribd, the manual opens with 

an explanation of why Windows slows down in the first 

place and follows up with illustrated Windows 7 and 

Windows XP explanations on maintaining performance, 

troubleshooting, and what to try when fixes don’t work.  

Specific topics address using system and data parti-

tions, upgrading RAM and freeing up RAM resources, 

properly uninstalling programs, cleaning a PC’s inter-

nals, addressing malware issues, Registry cleaning, and 

more. 
 

Reprinted with permission from CPU. Visit 
http://www.http://www.computerpoweruser.com 

Summary: Document backgrounds come in handy if you plan 

on converting the document to a Web page. Here's how you 

can add a background of your choice to your document. (This 

tip works with Microsoft Word 97, Word 2000, Word 2002, 

Word 2003, and Word 2007.)  

 

You probably are already aware that Word provides many 

different ways for you to get fancy with your documents. For 

instance, you can add graphics and WordArt that convey in-

formation much better—at times—than mere words alone can. 

 

One of the ways you can make your document fancy if it is 

destined for a Web page is to add a background. Simply fol-

low these two simple steps if you are using a version of Word 

prior to Word 2007: 

 

1.Choose Background from the Format menu. Word displays 

a small palette that shows colors and has a couple other choic-

es. 

 

2.Choose the color you want to use for the background of 

your documents. 

 

If you are using Word 2007, follow these steps instead: 

 

1.Make sure the Page Layout tab of the ribbon is displayed. 

 

2.Click the Page Color option in the Page Background group. 

Word displays a small palette that shows colors and has a cou-

ple other choices. 

 

3.Choose the color you want to use for the background of 

your documents. 

 

Word automatically switches to Online Layout view (Word 

97) or Web Layout view (Word 2000, Word 2002, and Word 

2003). Note that the color you selected is visible as a back-

ground for the document. You should note that the back-

ground colors are not visible in any other view. (In Word 

2007 the background color is visible in both Print Layout and 

Web Layout views.) If you switch to a view that doesn't sup-

port the background color, the document looks normal again 

(with a white background), but switching back to a supporting 

view again displays the same background color. 

 

If you want to get rid of the background, follow the same 

steps, above, but in the second step, choose "No Fill" or "No 

Color" from the color palette. 

 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 

permission. Thousands of free Microsoft Word tips can be found 

online at http://word.tips.net. 

Adding a Background  

to Your Document 

http://www.backupify.com
http://www.smartcomputing.com
http://word.tips.net
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Computer Systems Unlimited, Inc.  
 

We are a full service computer/peripheral 
sales and repair Company specializing in 
custom built Pc's, network design, software 
integration, and everything in-between. We 
are located in the small college town of 
Oberlin, Ohio, and for fourteen years have 

been providing unrivaled service to home users, small and large busi-
nesses all over Ohio as well as State and local government  agen-
cies.  All of our systems and networks are tailored to meet the individ-
ual needs of our customers. 
 

Onsite service and repair for all networks and systems, In house 
service and repair, Pick up and drop off,  Printer repair and cleaning, 
Laptop repair, Software troubleshooting, Custom designed networks 
and pc's, MAC repair, Parts replacement & Expert advice and support 
and Data Recovery. 
 

* Computer Systems Unlimited is happy to offer a 5% discount 
on all computer systems ordered by LCCUG members.  
* Computer Systems Unlimited will also offer a free computer 
diagnostics check, (a $25 value), for all LCCUG members.  
 

Visit our web site at www.csuoberlin.com for more of what we can do. 

Store Hour Monday 9-5:30 - Thursday 9-5:30 - Friday 9-5 - Saturday 9-1  

There are many ways that you can use Excel's tools to 
fill out various cells in a worksheet. One of the most 
common tools is to copy a cell (or cells) and then paste 
them into other cells. The only problem with this ap-
proach is that when you copy cells, you also copy the 
format of the original cells into the target cells. What if 
you just want to copy the values from the original cells, 
but retain the formatting already applied in the target 
cells? 
 

You probably already know that you can use the Paste 
Special option from the Home tab of the ribbon (Excel 
2007 and 2010) or the Edit menu (older versions of Ex-
cel), and then choose the Values option to paste just 
the values. If the target cells are right next to the original 
cells, there is an even easier way to accomplish the 
same task. Simply follow these steps: 
 

1. Select the original cells whose values you 
want to copy. 

2. Right-click on the fill handle (at the bottom 
right-corner of the selection) and drag the se-
lection to encompass the target cells. When 
you release the mouse button, a Context 
menu appears. 

3. Choose the Fill Values option. Excel fills the 
target cells with the values from the original 
cells; the formatting remains unchanged. 

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Excel tips can be 
found online at http://excel.tips.net. 

Copying Values 

Word automatically maintains several items of in-
formation about you, as a user. One such item is 
your address, which is changed on the User Infor-
mation tab of the Options dialog box. If you want to 
automatically insert the user address in your docu-
ments, you can follow these steps: 
 

1. Position the insertion point where you 
want the address inserted. 

2. Make sure the Insert tab of the ribbon is 
selected. 

3. In the Text group, click Quick Parts. You’ll 
see a drop-down menu. 

4. Choose Field. Word displays the Field dia-
log box. 

5. In the Categories drop-down list, choose 
User Information. 

The Field dialog box. 

 

6. In the Field Names list choose UserAd-
dress. 

7. Click on OK to close the dialog box and 
insert your field. 

 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 

permission. Thousands of free Microsoft Word tips can be found 

online at http://word.tips.net. 

Inserting the User's  
Address 

Don’t forget about the RootsMagic  

Webinars just go to:  

http://www.rootsmagic.com/webinars/ 

These are very informative webinars 

LCCUG Treasurer's Report 

1/19 Beginning balance  $   8,281.50  

  membership dues  $      475.00  

  Raffle proceeds after purchases  $      887.55  

  Membership printing & supplies  $     (147.30) 

3/28 LCCUG Certificate of Deposit  $   5,000.00  

3/28 General Fund balance  $   4,496.75  

http://www.csuoberlin.com/
http://excel.tips.net
http://excel.tips.net/
http://word.tips.net
http://www.rootsmagic.com/webinars/
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LCCUG O NGOING  CLASSES  
AND  WORKSHOPS  

 ALL  ARE  FREE  AND  OPEN  TO  THE  P UBLIC  

 

  Date:  Tuesday April 19, 2011 
  Time:  5:30 - 8 pm  Instructor:  Micky Knickman, et al. 

  Place:  Amherst Church of the Nazarene 
   210 Cooper Foster Park Rd.,44001 

 

 

   Learn how to repair or update your computer by changing 
hard drives, memory, CD ROMs, etc. 
 Members are encouraged to bring their computers any-
time before 7:30 pm for assistance from Micky, Neil or other 
knowledgeable members.  

Problem Solving Workshop 

NEED HELP?— 
Here’s Who to Contact: 

 
Neil Higgins 
  

 440-967-9061 - higgins.neil@gmail.com 
 Evenings 6 p.m. -10 p.m. + Weekends 
  Hardware, Linux & Windows Operating Systems,  
 Tweaking your system 

 

Micky Knickman 
     

 440-967-3118 - micky@knickman.com 
  Evenings 5 p.m. – 8 p.m. + Weekends 
   General Software Configuration, Hardware Installation,  
 Basic to Advanced Windows 
 

Lou Koch 
    

 440-985-1585 - lkkoch@centurytel.net 
   Microsoft Office: Excel, Word, PowerPoint, Publisher, Access, & 
 Outlook, Basic to Advanced Windows 
 

Edie Lewandowski 
    

 440-282-4188 - elew@erienet.net 
   Daytime - midnight 
   Desktop Publishing, General File Management, Eudora Email, 
 MSWorks Tools,  
 

 Richard Barnett 
      

 440-365-9442 - Richard216@aol.com 
    Evenings & Weekends 
   General Software Configuration, HardwareInstallation, Basic to 
 Advanced Windows & Web Page Design 

 

Sandee Ruth  
   

 440-984-2692 - sandee29@gmail.com 
  6 p.m. - 10 p.m. except when at work 
   Basic Word Processing, Windows,  & Web Design 

   Advanced Internet  
 

Jeff Kasler 
    

 440-967-7142 - Jeffk@roadrunner.com  
   10 a.m. - 7 p.m. 

   Burning CDs using Record Now  
 

David Kennett 
    

 440-327-8624 - w8kfj@yahoo.com 
 9 a.m. - 8 p.m.   
 Video Editing & DVD Burning 
 

Cathy Ratcliff 

 

 therats1@verizon.net 
 Though she lives in Coshocton, you can call  
 740-327-1483  before 8 pm 
 Paint Shop Pro, other Photo Editing programs, 
 Microsoft Office programs  
 
Keith Kuhn 
    

 440-967-6509 - kthkuhn@yahoo.com 
 8 a.m. - 11 p.m.   
 Downloading Music & Burning CDs 

Don’t forget to check the Members’ page for up-to-date infor-

mation about programs & events: 

http://www.lccug.com/members 

Date:  Tuesday April 19, 2011 
Time: 3:00 - 5:00 pm 
Instructor:  Pam Rihel 
Place:  LCCC Learning Center. 
  St. Joe’s Com. Center,  21st & Broadway 

  

 Learn more about finding your ancestors with public rec-
ords & online websites.  How to start & sources to use. 
 

You must register   -  Phone: 440-277-6076  or 
Email: LadyGeneo@roadrunner.com 

Genealogy Class 

Date:  April 12, 2011 
Time: 3:00 - 5:00 pm 
Instructor:  Jean Griffith 
Place:  LCCC Learning Center. 
  St. Joe’s Com. Center,  21st & Broadway 
 

Bring your questions if you’d like.  Jean will start with the 
basics and move on to intermediate topics if time allows. 
Learn MS Word, copying & pasting, for-matting text, saving 
files, basic file management, basic PC maintenance, etc 

 

Register by calling LCCC Learning Center:    
440-366-4507 

Beginning to Intermediate 

 Computing 

Jean Griffith will be teaching Beginning to Inter-

mediate Computing at her April 12th class.  If you 

are a beginner or have a better understanding of 

the computer this class is for you. 
 

YOU HAVE TO REGISTER for this class, look 

at the information listed above.  Jean needs to 

know how many students she will be teaching so 

she can be better prepared.  Thank You. 

mailto:higgins.neil@gmail.com
mailto:micky@knickman.com
mailto:lkkoch@centurytel.net
mailto:elew@erienet.net
mailto:Richard216@aol.com
mailto:sandee29@gmail.com
mailto:Jeffk@roadrunner.com
mailto:w8kfj@yahoo.com
mailto:therats1@verizon.net
mailto:kthkuhn@yahoo.com
http://www.lccug.com/members
mailto:LadyGeneo@roadrunner.com
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April 2011 Classes 

Class Type Location Registration April Time More Info 

Classes / Workshops 

Problem Solving 
Micky Knickman 

Amherst Church of 
the Nazarene 
210 Cooper Foster 
Park 

  
Not Required 

April 19, 2011 
5:30 to 8:00 

pm 
Page 10  

Genealogy Class 
Online & Off 
Pam Rihel 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Reg. required  
 

LadyGeneo @ 
roadrunner.com 

April12, 2011  3:00-5:00 pm Page 10 

Beginning to Inter-
mediate Computing 
Class 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Jean Griffith 
 

Register by call-
ing:    

440-366-4507 

April 12, 2011  3:00-5:00 pm Page 10 

Is there a class you would like to teach or a class you would be interested in attending, please let one of our 
officers know. 

We want to fill this last row with something new to be taught.  

The Lorain County Chapter of OGS 
is having it’s next  meeting on : 

 

April 11, 2011 - Using Maps in Genealogy - Speaker: Tom 

Edwards. 
 

Saturday April 9: Beginning Genealogy Part I hosted by 

Margaret Cheney. Topics: Beginning Your Journey, Re-

searching Vital Records will be from 10:30 am to 2:30 pm. 

To register contact the library at 440-327-8326 or send Mar-

garet an email at margcheney@aol.com. Don't forget to 

bring a brown bag lunch. This is a free program. 
 

Meetings are held the 2nd Monday of the month in the North 

Ridgeville Library on Bainbridge Rd., east off Rt. 83-just 

south of Rt. 20.   

 

Meetings start at: Social time 6:30; and 7:00 PM for the pro-

gram.  Meetings are free and open to the public. 
 

Come and enjoy some interesting genealogy programs. 

For direction's to North Ridgeville Library follow this link. 
 

http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-
82.014903&zoom=16&q1=35700%20Bainbridge%

20Road%20North%20Ridgeville%2C%20OH%
2044039 

On Site or Walk In Services  

440-322-0259 
210 East Second St., Elyria 44035 

New Systems Upgrades 

Diagnostics Installations 

Virus Removal System Tune Ups 

Rebuilt Systems 

Finding a Date From The Past 
 

Type in the Google search box: calendar +, then the 
date you are looking for , example: calendar +1954.  
This will bring you to all the months in the year of 1954. 

mailto:LadyGeneo@roadrunner.com
mailto:LadyGeneo@roadrunner.com
mailto:margcheney@aol.com
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com/
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
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Ohio Computer Repair Service 
47375 Cooper Foster Park Road 

Amherst, Ohio 44001 
(440) 984-5265 

 

The Problem: 

Computers can be fun and frustrating at the same time. 
This may be a surprise to some, but 90% of everything that goes 
wrong with a computer is configuration related. The problem is, 

there are just too many settings to change and modify, and most 
people don't even know where these settings are.  

The Answer: 
You could read and study like I did for the last 14 years. You 

could experiment with your computers on a daily basis until you 
get it right, or search the Internet and find more sites than any 

ten people could read in a lifetime. You could accidentally break 
your computer more times than you care to remember, or you 

can call us, Ohio Computer Repair Service.  

The Result: 
A computer that runs all the time with no errors, no surprises, 

and does it faster and better than when it was brand new. 

Boot Up To The Repair Disc 

Now that you’ve created the disc, place it in your CD or DVD 

drive and boot the computer.  In most systems pressing F2 

during the initial boot (the computer’s startup process) will 

bring up a Press Any Key To Boot From CD or DVD option.  

(The correct keypress may vary from machine to machine, so 

check your users manual.)  Press a key to boot from the Sys-

tem Repair Disc you placed in the drive.  You’ll only have a 

few seconds to respond to the prompt.  If you miss it, you’ll 

need to reboot and try again. 
 

It’s pssible that you’ll need to enter the system BIOS (Basic 

Input/Output System) and reset your boot options to allow 

booting from an optical drive.  To enter the BIOS, press DE-

LETE (or ESC or F2, etc., depending again on your particular 

system) repeatedly during bootup.  Once at the BIOS menu, 

go to the Boot, Boot Order, or similarly named menu.  Place 

your optical drive first in the list of boot options.  Be sure to 

save your changes before exiting. 
 

In the System Recovery Options dialog box, select your lan-

guage.  The system will then search your computer for previ-

ously created system images.  If you created a backup image 

earlier, you can use that image to restore your system at this 

point, if you like. 
 

Otherwise, select your OS (Operating System; Win7 may be 

the only one listed) and click Next.  At this point, the System 

Recovery Options dialog box will display a list of five tools: 

Startup Repair, System Restore, System Image Recovery, 

Windows Memory Diagnostic, and Command Prompt. 
 

Using the System Recovery Options 

Startup Repair.  The Startup Repair option may be the most 

useful of the five utilities, because many system issues are 

caused by (or reflected in) startup-related problems.  These 

can include slow boots, Registry problems, and lockups dur-

ing boot, etc. 
 

When you select the Startup Repair option, Windows will 

(Continued on page 16) 

Built-In Restore & Stabilize 

Windows 7 
 Create & Use A Repair Disc 
 

By Rod Scher 
 

If your Windows 7 computer has been acting up on you – 

crashing, locking up, booting slowly, or exhibiting  other 

problems – don’t dispair.  You might already have on hand 

exactly the tool you need to repair and rejuvenate your sys-

tem.  Win7 includes a series of useful system recovery op-

tions and a tool to create a bootable disc that can take you 

right to those options.  We’ll show you how to access the set 

of utilities that can bring your computer back to life. 
 

Create Your Win7 Repair Disc 

Generally, the tools are accessed via a System Repair Disc 

(occasionaly called a Recovery Disc in some versions of 

Win7), and there are several ways to create one of those discs. 

(And one instance in which creating a disc may turn out to be 

unnecessary:  See the ―Pre-Installed System Recovery Tools‖ 

sidebar.)  Note that in all the instances we’ll describe, the 

ultimate goal is to end up at Win7’s Create A System Repair 

disc dialog box, from which point the system can take over 

and create the actual disc. 
 

Use the Backup and Restore option. 

One common way to create the disc is to use the Control Pan-

el’s various backup options to do so.  Open the Control Panel 

and select Backup Your Computer and then click the Create 

A System Repair Disc link on the far left.  Assuming that 

your system is equipped with a CD/DVD burner, the Create A 

System Repair Disc dialog box will appear.  (If there is no 

burner present, an error message to that effect will appear.) 
 

Use the Maintenance tool 
If you’d rather, you can click Start and All Programs.  Select 

the Maintenance folder and then select Create A System Re-

pair Disc.  (In some versions of Win7, the option may be Cre-

ate Recovery Disc instead.)  The Create A System Repair 

Disc dialog box will appear. 
 

Run the Recdisc.exe utility. 

Perhaps the simplest way to create a System Repair Disc is to 

click Start, type recdisc.exe in the text box, and press EN-

TER.  The dialog box will appear.  (The ―recdisc‖ utility 

name -  standing for Recovery Disc – is a holdover from 

Vista.  Win7 usually refers to the disc as a Repair Disc but 

some versions occasionally refer to it as a Recovery Disc.  

Same thing, two different names.) 
 

Click Create Disc.  It will take a few minutes to create the 

System Repair Disc, after which Windows will display anoth-

er dialog box reminding you to label it.   
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Malware, Viruses,  

Trojans Defined 

 
by Ira Wilsker  

  

In the past week, I was called upon four more times to clean 

malware off of infected computers. One user had a major 

name brand antivirus program installed, running, and updated 

and could not understand how the malware had penetrated his 

antivirus software and contaminated his computer.  He had 

purchased the antivirus software last fall from a big box elec-

tronics store based on the recommendations of a salesper-

son.  He had been told that this particular brand of security 

software was the best as it was their top seller, and that antivi-

rus software was all that he really needed.  Based on that rec-

ommendation he plopped his hard earned money on the coun-

ter, went home, installed it, updated it, and blissfully surfed 

the internet, opened email attachments, downloaded software 

and music, and had just a jolly good time online until his 

computer gradually slowed to a crawl, and friends informed 

him that they were receiving spam emails from him.  This 

user was perplexed, as his antivirus software was running, and 

indicated that it was updating several times a day.  He just 

could not understand how 90 different malware programs had 

infected his computer.  His problem started when he pur-

chased inadequate security software; while the product he 

bought was excellent at protecting his computer from viruses, 

and some Trojans and spyware, it did not offer the all-

inclusive protection of the comprehensive security suite of-

fered by that publisher (and others as well) that would have 

only cost him a few dollars more. 

 

There is a common misconception in user circles that viruses 

are the primary computing threat, as users have heard about 

viruses for several years.  Today, viruses are present, but a 

relatively minor threat in terms of  prevalence.  I did a quick 

analysis of the most common new threats recently listed by 

TrendMicro, and found that viruses only made up 4% of the 

new significant threats to our computing security.  On the 

other end of the spectrum, Trojans made up 42% of the com-

monly seen new threats, worms were at 14%, backdoors at 

14%, web based threats were at 6%, java script malware was 

at 6%, 4% were hacking utilities, 2% adware, and about 8% 

other threats.  It is obvious that protective software that pro-

tects the computer primarily from viruses is failing to protect 

the user from the majority of contemporary threats; it is pre-

cisely this fact that led to this user's infected computer, de-

spite his premium quality antivirus software.  A lot of users 

have a misconception about the common threats in circula-

tion, believing that they are generically all viruses, but, as I 

saw in this case, this blissful ignorance may lead to a compu-

ting nightmare. 

 

While not necessary to use a computer, it would likely be 

beneficial for computer users to be aware of the different 

threat groups that can impact our computing.  According to 

Wikipedia, "A computer virus is a computer program that can 

copy itself and infect a computer."  Many viruses attach them-

selves to legitimate programs or data files on the infected 

computer.  The fact that a computer virus can copy itself to 

infect other computers is what makes it different from other 

types of malware, for which viruses are commonly con-

fused.  Viruses can be spread through digital media (USB 

drives, CD or DVD discs, and floppy discs) or through net-

work connections that the virus can use to copy itself to other 

attached computers.  Once a virus has infected a computer it 

may perform a variety of tasks as programmed by its au-

thor.  Viruses may damage the data on a hard drive or degrade 

the performance of the computer.  Some of the viruses are 

stealthy and their effect may not be noticeable by the user, as 

the viruses do their damage in the background.  Some viruses 

are functionally benign, other than they reproduce themselves 

countless times on the infected hard drive, until they consume 

all of the free space on the hard drive. 

 

Computer worms are a malicious computer program that 

wriggles through computer networks sending copies of itself 

to other computers attached to the network.  Most worms are 

free standing programs, and are commonly programmed to 

spread themselves through the network without any action by 

the user.  Most worms have an explicit nefarious function 

such as deleting files on the infected computer, or encrypting 

critical files, only releasing them after an extortion payment is 

made to the cyber criminal.  Some worms open a backdoor 

into the computer that will enable the creator of the worm to 

take remote control of the computer, converting the computer 

into a "zombie" under his control, which can be used to gener-

ate revenue for the originator of the worm by sending spam 

mail from the infected computer, with the spam fees collected 

going to the author of the worm.  Some worms are used to 

create a zombie network of computers, also called a "botnet", 

where the compromised computers can be used to launch di-

rected cyber attacks on other computers or networks, in an act 

of cyber terrorism. 

 

For those who are aware of the epic "Helen of Troy" of Greek 

mythology, the term "Trojan Horse" means an object that 

looks like it serves one purpose, but really has an unobvious, 

usually nefarious, purpose.  Cisco, the networking company, 

describes a Trojan as, "It is a harmful piece of software that 

looks legitimate. Users are typically tricked into loading and 

executing it on their systems". In cyber speak, a Trojan Horse, 

typically shortened to the simple moniker "Trojan" is a pro-

gram that appears to have a useful function, but after being 

installed by the user, the Trojan may be used to perform other 

undesirable functions.  Some Trojans are money makers for 

their authors because they place paid (and usually unwanted) 

pop up advertisements (Adware) on the infected computer, 

redirect web searches, or shift online purchases to a seller not 

of the buyer's choice without his knowledge.  Some Trojans 

are keyloggers, which are commonly used for identity theft, 

or to give unauthorized users access to a computer sys-

tem.  Trojans are often spread through intentionally down-

loaded software, surreptitiously bundled with another often 

legitimate program, from email attachments, and purloined 

(Continued on page 15) 
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News, Views & Tips 
 

Compiled by Joseph Moran  
 

Microsoft News 
Hotmail Introduces Email Aliases  

A new feature in Hotmail lets users set up and manage 
multiple secondary email addresses, also known as ali-
ases, from within a single Hotmail account. Aliases are 
unique and expendable email addresses you can use to 
receive or send mail for specialized purposes (such as 
marketing lists, job hunting, or online shopping) when 
you don’t want to divulge your primary email address. 
 

Hotmail users can now create up to five aliases per year 
and up to 15 aliases total. 
 

Microsoft releases Survey Location-Based 
Services  

In connection with Digital Privacy Day 2011, held on 
Jan. 28, Microsoft released the results of a survey it 
commissioned regarding consumer awareness and use 
of LBS (location-based services). The survey ques-
tioned 1,500 people in the United States, Canada, Ja-
pan, Germany, and the UK and found that while 51% of 
respondents had used LBS before and 94% of those 
users had found it ―valuable,‖ more than 80% were con-
cerned about the loss of privacy and potential for data 
and/or identity theft when sharing their locations. 
More of Microsoft’s survey findings, as well as some tips 
on how to mitigate the privacy risks of LBS, are availa-
ble at www.microsoft.com/privacy/dpd. 
 

Windows Tips 

Set Up A Temporary Windows Account 
Lockout 
If you frequently leave your computer unattended and 
are concerned about passers-by potentially gaining ac-
cess by repeatedly trying to guess your password, you 
can get a little extra peace of mind by configuring your 
system to temporarily lock your account after a certain 
number of incorrect password entries.  
 
To set this up on a Win7 or Vista system with the Pro-
fessional/Business or Ultimate versions of the OS, make 
sure you’re logged in with an administrative account. 
Click Start and type local in the Search box. Select Lo-
cal Security Policy from the Start menu. Now double-
click Account Policies, Account Lockout Policy, and Ac-
count Lockout Threshold. Specify the number of invalid 
logon attempts you want before triggering a lock—3 or 5 
are reasonable choices—and click Apply and OK. 
 
Next, a window will appear indicating that the two relat-
ed settings—Account Lockout Duration and Reset Ac-

count Lockout Counter After—will each be changed to 
the suggested value of 30 minutes. You can change 
either setting afterward if you choose. (The lockout 
counter setting refers to how long the system will re-
member an incorrect password and count it against the 
threshold.) 
 

You can also set 
up account lock-
out on a Win7/
Vista Home Pre-
mium, Basic, or 
Starter system, 
but the procedure 
is different be-
cause those ver-
sions lack the 
Group Policy Edi-
tor.  On any of 
these Windows 
versions, type 
command in the 
Start menu’s 
Search box, right-
click Command 
Prompt, and then 
select Run As Administrator. In the Command Prompt 
window, type net accounts /lockoutthreshold:x 
(where ―x‖ is the number of bad attempts you want to 
trigger the lockout). The account lockout duration and 
reset counter time are automatically set to 30 minutes 
for you, though here the latter setting is actually called 
Lockout Observation Window. To change these set-
tings, type net accounts /lockoutwindow:x and net 
accounts /lockoutduration:x where ―x‖ is the number 
of minutes. (NOTE: You need to change the lockout 
window before you can change the duration.) To see the 
settings without making any changes, simply type net 
accounts and to disable account lockout, type net ac-
counts /lockoutthreshold:0. 
 

Take care when using the account lockout setting, be-
cause if you mistakenly mis-type your password a few 
times, you could inadvertently lock yourself out of an 
account, albeit temporarily. 
 

Hide The Microsoft Office Ribbon 
Although it takes some getting used to for longtime Of-
fice 2003 users, the Ribbon interface in Office 
2007/2010 does help keep the program’s myriad fea-
tures within easy reach. The flip side is that the Ribbon 
takes up a fairly large amount of space, which can be a 
problem when you’re working on a document on a rela-
tively small screen. 
 

To temporarily reclaim some space for your document, 
you can hide the Ribbon by double-clicking the currently 
selected menu tab or by pressing CTRL-F1. 
 

(Continued on page 15) 

An account lockout can help 
thwart those who walk up to 

your computer and try to 
guess the password. 

http://www.smartcomputing.com/
www.microsoft.com/privacy/dpd
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Windows News 
Nokia To Adopt Windows Phone 7  
Microsoft and Nokia have announced a partnership that 
will make Windows Phone 7 the ―principal operating 
system‖ on future Nokia smartphones. Under terms of 
the agreement, Nokia will also collaborate with Microsoft 
on future Windows Phone 7 development and merge its 
own Ovi content and application store with Microsoft’s 
Windows Phone 7 Marketplace. 

 
 
 

The two companies plan to build 
a new mobile ―ecosystem‖ that 
they hope will rival that of Goog-
le’s Android and Apple’s iPhone. 
The alliance also likely marks the 
beginning of the end for Symbi-
an, Nokia’s current OS, though 
there’s no indication of exactly 
when Nokia’s first Windows 
Phone 7-based devices will hit 
the market. 

 

Windows 7 Service Pack Released  
Service Pack 1 for Windows 7 (and Windows Server 
2008 R2) is now available for download via Windows 
Update or at tinyurl.com/36prwjl. SP1 doesn’t bring 
any major new features to Win7, though it includes pre-
viously released updates along with a few new fixes re-
lated to HDMI (High-Definition Multimedia Interface) au-
dio devices and XPS document printing problems. 

 

Microsoft Distributes Windows Auto-
run Update.  Microsoft recently distribut-
ed a patch (KB967940) for Windows 
Vista and WinXP systems via Windows 

Update that disables the Autorun feature for USB-based 
flash memory and hard drives. The move aims to thwart 
the spread of certain kinds of malware that automatically 
execute when an infected storage device is inserted, 
such as the notorious Conficker worm that took ad-
vantage of Autorun to spread around the globe in late 
2008 and early 2009. 
 

The Autorun update doesn’t apply to Win7, which disa-
bles Autorun by default. A Microsoft Fix It is available at 
support.microsoft.com/kb/967715 that can automati-
cally enable or disable Autorun on any Windows sys-
tem. 
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

(Continued from page 14) Microsoft News, Views & Tips 
 

Nokia released this image 
showing what some of the 

company’s future Win-
dows Phone 7-based 

devices might look like. 

websites with executable content (ActiveX is sometimes used 

for this).  Some Trojans can be installed on the target comput-

er by way of code written in Java, or a Java script, that when 

executed, implants the harmful content on the victim comput-

er. 

 

One of the more recent and costly types of malware to attack 

our computers is generically referred to as "Rogue Antivirus 

Software", which is usually implanted on the victim's comput-

er by a Trojan.  There are thousands of these rogue programs 

in current circulation, infecting millions of computers at any 

given time.  Rogue antivirus is sometimes installed by the 

user using "social engineering" tactics, which tricks the user 

into clicking on something that installs the rogue soft-

ware.  Some of the common lures to ensnare the user into 

loading rogue software on the computer are offers for free 

screen savers, toolbars, utilities to play specific video formats 

(often attached to an email), sham online security scanners, 

contaminated PDF files, insecure web browsers, and other 

vectors.  The common thread of this rogue software is an au-

thentic looking  popup that informs the user that his computer 

is (falsely) infected with hundreds of viruses and Trojans, and 

for a fee it will clean the computer.  These popups which will 

not permanently close will typically hijack the computer, de-

stroy the installed legitimate security software, prevent access 

to online services that can kill it, prevent cleaning utilities 

from executing, and otherwise take control of the computer 

until the user pays a fee, typically $30 to $70.  This fee is to 

be paid by credit card or other online payment service to a 

website that looks legitimate, but is really a complete 

scam.  Not only will the rogue software not clean the comput-

er of the pseudo infections after the fee is paid, but now a 

cyber criminal, often in Russia, has the user's credit card in-

formation.  It is not uncommon for that same credit card in-

formation to promptly be sold on illicit websites, and to have 

substantial unauthorized charges appear on the compromised 

credit card account. 

 

While there are many other cyber threats out there, those 

listed above are among the most commonly encountered by 

users.  The traditional antivirus software will protect from 

some of the threats listed, but not all of them; this enhanced 

security capability is in the purview of the comprehensive 

security suite, or a combination of different types of individu-

al security utilities, and not the freestanding antivirus pro-

gram.  This is explicitly why I currently recommend a high 

quality integrated security suite, rather than an antivirus pro-

gram.  There are several good commercial security suites 

available, as well as a few free security suites.  Just be aware 

that antivirus software by itself is inadequate to protect 

against today's contemporary cyber security threats. 

 
There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 
organization of which this group is a member, brings this article to you. 

(Continued from page 13) Malware, Viruses, Trojans Defined  
 

tinyurl.com/36prwjl
http://support.microsoft.com/kb/967715
http://www.smartcomputing.com
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Absolutely Positioning a 
Picture 
Summary: Want a graphic to appear at a precise place 
on the page? It's easy to gain control by following the 
steps in this tip. (This tip works with Microsoft Word 97, 
Word 2000, Word 2002, Word 2003, and Word 2007. 
You can find a version of this tip for the ribbon interface 
of Word (Word 2007 and later) here: Absolutely Posi-
tioning a Graphic.)  
 

Word, as you know, allows you to insert pictures into 
your documents. When you insert a picture, it is basical-
ly placed where your insertion point is located. You have 
total control, however, over where your picture is posi-
tioned on a page. 
 

Let's say, for instance, that you want your picture to ap-
pear exactly 3 inches from the top of the paper, and 2 
inches from the left side of the paper. In order to effect 
this positioning, you would follow these steps if you are 
using Word 2007: 
 

1.Insert your picture as you normally do. 
 
2.Click on the picture one time to select it. 
 
3.Make sure the Format tab of the ribbon is dis-
played. 
 
4.In the Arrange group, click the Position tool. Word 
displays a number of stock ways in which the image 
can be positioned. 
 
5.Click More Layout Options. Word displays the Ad-
vanced Layout dialog box. 
 
6.Make sure the Text Wrapping tab is displayed. 
(Click here to see a related figure.)  
 
7.Select one of the Wrapping options except In Line 
With Text. 
 
8.Click the Picture Position tab. (Click here to see a 
related figure.)  
 
9.In the Horizontal area of the dialog box choose the 
Absolute Position radio button and set the picture to 
be 2 inches to the right of Page. 
 
10.In the Vertical area of the dialog box choose the 
Absolute Position radio button and set the picture to 
be 3 inches below Page. 

(Continued on page 17) 

scan your computer and look for problems.  If you have a 

corrupted Registry or damaged system files, the tool can often 

correct them.  Keep in mind that your system may reboot dur-

ing the repair process, so don’t worry if that happens. 

 

The utility will check hard drive integrity, status of updates, 

and the computer’s boot logs and then it will attempt to cor-

rect any errors it finds.  Once it’s finished, you can select 

View Diagnostic and Repair Details to see what it found.  If 

the utility finds problems that it cannot correct, it will display 

a problem summary that may include links you can use to find 

more information. 

 

System Restore. 

System Restore accesses a series of previously saved restore 

points to allow you to revert your system to an earlier (and 

presumably more stable) version that contains working ver-

sions of the Registry, applications, and system files.  To re-

store to an earlier version, select the System Restore option 

from the list; the system will present a list of restore points to 

which you can restore your system.  Select a restore point that 

was created prior to the point at which you began having 

problems.  Keep in mind that, by restoring, you will lose any-

thing you’ve installed or updated since that date. 

 

System Image Recovery. 

This is not the same as a System Restore, described above.  

While a System Restore utilizes multiple (often system-

created) restore points to ―roll back‖ your computer, a System 

Image Recovery relies on your having previously created a 

system image backup – preferably prior to the point at which 

your problems began.  Be careful: Restoring from an image 

will replace everything on your drive with the content of the 

image.  You’ll lose anything you’ve added since the image 

was created, including documents, photos, and applications. 

 

Windows Memory Diagnostic 

Bad memory can cause bad problems: frustrating, often inter-

mittent problems that range from random reboots to failure to 

boot altogether.  This diagnostic runs a series of tests de-

signed to check your computer’s RAM. 

 

Select the Windows Memory Diagnostic option.  Your system 

will reboot and begin checking its memory.  The process can 

take several minutes.  When the test finishes, the system will 

reboot again and display a log describing the results. 

 

Replacing memory is simple and relatively inexpensive, so if 

your problem does turn out to be RAM, the solution is usually 

straightforward. 

 

Command Prompt 

Win7 includes (and third-party vendors also offer) command-

line based utilities that let you tinker with the OS at a very 

low level.  These tools can be very useful, but they can also 

be dangerous:  They’ll let you do just about anything, even if 

(Continued from page 12) Built –in, Restore & Stabilize.. 

(Continued on page 17) 

http://wordribbon.tips.net/Pages/T008714_Absolutely_Positioning_a_Graphic.html
http://wordribbon.tips.net/Pages/T008714_Absolutely_Positioning_a_Graphic.html
http://word.tips.net/FigFiles/T1441F1.html
http://word.tips.net/FigFiles/T1441F1.html
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11.Make sure the Move Object with Text check box 
is cleared. 
 
12.Click OK. 
 

If you are using Word 2002 or Word 2003, follow these 
steps: 
 

1.Insert your picture as you normally do. 
 
2.Click on the picture one time to select it. 
 
3.Choose Picture from the Format menu. Word 
displays the Format Picture dialog box. 
 
4.Make sure the Layout tab is selected. (Click 
here to see a related figure.)  
 
5.Select one of the Wrapping options except In 
Line With Text. 
 
6.Click the Advanced button. Word displays the 
Advanced Layout dialog box. 
 
7.Make sure the Picture Position tab is selected. 
(Click here to see a related figure.)  
 
8.In the Horizontal area of the dialog box choose 
Absolute and set the picture to be 2 inches to the 
right of Page. 
 
9.In the Vertical area of the dialog box choose Ab-
solute and set the picture to be 3 inches below 
Page. 
 
10.Make sure the Move Object with Text check 
box is cleared. 
 
11.Close both of the open dialog boxes. 
Finally, if you are using Word 97 or Word 2000 you 
should follow these steps: 

 

1.Insert your picture as you normally do. 
 
2.Click on the picture one time to select it. 
 
3.Choose Picture from the Format menu. Word 
displays the Format Picture dialog box. 
 
4.Make sure the Position tab is selected. 
 
5.Using the Horizontal field, and its associated 
From drop-down list, specify 2 inches from the 
Page. 
 
6.Using the Vertical field, and its associated From 
drop-down list, specify 3 inches from the Page. 

(Continued from page 16) Absolutely Positioning A Picture 
 

 
7.Make sure the Move Object with Text check box 
is cleared. 
 
8.Click on OK. 

 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 

permission. Thousands of free Microsoft Word tips can be found 

online at http://word.tips.net. 

Keep It Cool 
 

Computers generate quite a bit of internal heat, especially if 

they are running video or audio applications or multiple pro-

grams simultaneously. Excess heat over prolonged periods 

of time can damage components and connections, not to 

mention affect performance. All computers are equipped 

with fans that dissipate the heat, but sometimes they can’t 

keep up, especially if the vents are blocked or occluded by 

dirt and dust. In addition to keeping the vents clear, you can 

keep your computer cool and healthy by keeping the room 

temperature lower and making sure air can circulate around 

your computer.  

 
Reprinted with permission from Smart Computing.  Visit 

http://www.smartcomputing.com to learn what Smart Computing can 
do for you and your user group! 

it’s wrong. 

 

If you need to run a command-line tool, select this link.  A 

command Prompt window will open.  From within it, assum-

ing you know the DOS-derived commands and switches, you 

can move from one drive to another, invoke programs, copy 

and delete files, and more.  Just be careful in there.  If you’re 

using a command line-based tool, be sure to follow the in-

structions very carefully. 

 

The Right Tools for the Job 

Win7 is probably the most stable, trouble-free OS ever re-

leased by Microsoft, but it’s still a complex piece of software 

that must run in thousands of different configurations and 

work with an almost infinite number of applications and driv-

ers.  Things can go wrong.  When they do, your Win7 System 

Repair Disc may be able to help you clean up Windows and 

get it running smoothly again. 
 

There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 

organization of which this group is a member, brings this article to you. 

(Continued from page 16) Built-in, Restore & Stabilize... 

Genealogy Web Sites 
 

Passenger Ship Arrivals 

http://www.daddezio.com/genealogy/ships/index.html 
 

My Heritage Family Tree Site 

http://www.myheritage.com/ 

http://word.tips.net/FigFiles/T1441F3.html
http://word.tips.net/FigFiles/T1441F3.html
http://word.tips.net/FigFiles/T1441F4.html
http://word.tips.net
http://www.smartcomputing.com/
http://www.smartcomputing.com
http://www.daddezio.com/genealogy/ships/index.html
http://www.myheritage.com/
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Excel’s New Sparklines 
 

BY TREVOR MEERS 
 

It seems like every version of Microsoft Excel released over 

the years has brought a faster way of making charts. Excel 

2010 takes the evolution to a completely new concept with the 

introduction of sparklines. Excel’s regular charts are already 

pretty quick to create, but with the tiny sparkline charts, you 

can have instant micro charts in the same row as the data they 

portray. Because the small charts are embedded throughout a 

worksheet, it’s easy to provide at-a-glance data summaries 

right next to the data, wherever it occurs. Sparklines are com-

pact enough that they won’t take up a lot of space on the 

worksheet or interrupt the overall look, and when you print a 

worksheet, the sparklines print, too. 

Sparklines require you to shift your thinking about charts a bit 

in this way: They don’t exist as separate objects in the work-

sheet. They live right inside a cell, just like a number or text. 

This integrates them fully into the data they represent. If you 

cut and paste a group of cells, you can highlight the 

sparkline’s cell, too, and move it right along with the data. 

And because the sparkline lives in the cell’s background, you 

can put text messages over the top of the little charts in state-

ments, such as ―110% growth over last year!‖ 
 

A Variety Of Choices 
The variety of available sparklines lets you graphically show 

rather detailed data trends or choose simple representations 

that indicate base information, such as whether a quarter’s 

revenues showed a profit or loss. And once you’ve created a 

sparkline, it automatically adjusts itself each time its source 

data changes. 
 

Create Sparklines 
Assuming your worksheet already contains cells full of data, 

here’s how to create sparkline charts that tell the story. Click 

the cell where you want the sparkline to appear, then go to the 

Ribbon’s Insert tab and click one of the chart types in the 

Sparklines section. After you select a chart type, such as Line, 

a dialog box asks you to select the cell range that will provide 

the chart’s information. You can simply highlight the correct 

cells to tell Excel what information to use. 
 

After your new sparkline appears in the cell, you can custom-

ize it with several tools that appear on the Ribbon. A group of 

checkboxes lets you indicate which data points are marked 

with a little box on a line chart.  Markers are a good choice, 

as it puts a box on each data point. Color tools let you choose 

colors for the markers and the data line itself. 
 

If you want to create several sparklines at the ends of several 

rows of data, highlight the entire block of cells.  Then, click a 

sparkline type on the Insert tab.  When the dialog box ap-

pears, highlight the cells that will contain the charts and click 

OK.  If you already have a series of sparklines, you can in-

stantly add another one (assuming there’s data to support it) 

by clicking the last cell that contains a sparkline and dragging 

the fill handle onto new cells. 
 

As you format sparklines, remember that Excel treats groups 

of sparklines as a unit. If you highlight the last sparkline in a 

group of four, you’ll see that any formatting changes you 

make will be applied to all the sparklines. 
 

If you want to remove a sparkline, simply right-click its cell 

and choose Sparklines and Clear Selected Sparklines.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

"Excel"erate PowerPoint 

Slides 
If your Microsoft PowerPoint presentation covers topics such 

as sales growth or profits forecasts, adding an Excel chart is 

probably an ideal method to convey such information. In 

PowerPoint 2003 you can create an embedded Excel chart in 

a slide. Select the slide in which you want to add a chart. 

Next, open the Insert menu and click Object. In the resulting 

dialog box, select the Create New radio button, click Mi-

crosoft Excel Chart in the Object Type list, and click OK. 

PowerPoint will insert a dummy chart with sample data; 

click the Sheet1 tab at the bottom of the chart layout to re-

place the sample data.  
Reprinted with permission from Smart Computing.  Visit 

http://www.smartcomputing.com to learn what Smart Computing can 
do for you and your user group! 

Microsoft Office 2010 

Excel’s new sparkline feature lets you quickly insert micro charts 
next to the source data, Providing at-a-glance summaries of your 

information. 

Useful links: 

Windows Media Player 12 Online Radio:  Windows Me-
dia Player 12 features the ability to play online radio.  
 

Complete Guide to Windows Libraries 

 

Burning DVDs with Windows DVD Maker 

 

6 Best Free DVD Authoring Freeware to Create DVDs 

from Home Movies 

 

Magix FunPix Maker 

 

http://www.smartcomputing.com
http://www.smartcomputing.com/
http://www.smartcomputing.com
http://www.smartcomputing.com/
http://www.worldstart.com/windows-media-player-online-radio/
http://www.worldstart.com/windows-libraries/
http://www.worldstart.com/burning-dvds-with-windows-dvd-maker/
http://www.ilovefreesoftware.com/08/featured/6-best-free-dvd-authoring-freeware-to-create-dvds-from-home-movies.html
http://www.ilovefreesoftware.com/08/featured/6-best-free-dvd-authoring-freeware-to-create-dvds-from-home-movies.html
http://www.worldstart.com/magix-funpix-maker/
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USB Drive Scams 
 

As the data we use and store on our PCs grows, so too 
does our hunger for higher-capacity storage devices, 
including USB flash drives.  
 
Crooks, mainly based in China, Hong Kong and India, 
have used the opportunity this creates for a scam by 
creating knock-off designs of well-known drives, chiefly 
the highly-reputable Kingston brand, and lying about 
their supposed capacity.  
 
These phony devices sometimes do work but have 
nowhere near the capacity claimed on the label.  
Devices with claimed capacities of 32, 64 and even 
128 gigabytes are being sold online, when they real-
ly only hold 4 or 8 gig.  
 
Buyers can't necessarily tell because the scammers 
hack the devices so that they show the wrong, higher 
capacity even when you check this on your PC.  
 
You don't find out until you run out of space far earlier 
than you thought you would.  
 
The giveaway on this USB scam is usually the price -- a 
third or a quarter of what the genuine item would cost.  
 
Time to repeat our favorite warning: "If it looks too 
good to be true, it probably is."  
 
This scam is the subject of a lot of debate on eBay fo-
rums, so check that site out for more information on 
what to look for and how to protect your interests.  
 
Go to http://forums.ebay.com, click on the "Search" 
button and enter in "USB drives."  
 
Let's face it, USB drives are a boon -- especially as we 
so often move data between PCs, both in the home and 
between home and work.  
 
They're light and easy to use and transport. But that's 
also their weakness -- it makes them vulnerable and 
potentially expensive.  
 
So, be cautious rather than curious with others' drives, 
be wary when using shared machines, and don't fall for 
those cheap "high capacity" drives. Those are our sim-
ple rules for USB safety first!  
 

Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

ScamBusters at http//www.scambusters.org 

USB Safety Alert 
 

While many people think of computer security as an In-
ternet access issue, USB safety and scams relating to 
these popular "thumb drives" should not be overlooked.  
Those rectangular USB ports on PCs have become an 
essential part of everyday computing.  
 

We connect all manner of devices with them to store 
and transfer data, from hard drives to digital cameras.  
But the USB storage devices, also sometimes known as 

"flash drives" or, in Europe, "pen drives," pose a 
particular security threat because of their easy 
portability and increasing capacity.  
 

They're used to steal information, install malware 
on PCs and even for conning people into buying 
them when they're next to useless.  

 

And, as usual, the ingenuity of crooks pulling fast ones 
knows no boundaries.  
 

For instance, the New York Times reported recently that 
employees of a company found a number of USB drives 
bearing the firm's logo scattered around its parking lot.  
Curiosity being what it is, several employees picked 
them up, took them into the office and plugged them into 
their PCs to see what was on them.  
 

They found what appeared to be a document but when 
they clicked on the icon, it installed malware that was 
intended to steal confidential information directly from 
the company's computer network.  
 

Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

Scambusters at http//www.scambusters.org 

CHOW 
 

If you aren’t hungry yet, you will be by the time you pull 
yourself away from CHOW. The site has enormous, 
gorgeous shots of tasty dishes, along with the recipes 
that will help you make them for your family.  

http://www.chow.com  

open system  
 

In communications, a network designed to incorporate 
devices from any manufacturer, as long as they can 
use the same communications protocols and facilities. 
Alternately, when applied to specific hardware or soft-
ware, an open system is one that accepts add-ons from 
third-party suppliers.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 
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http://forums.ebay.com
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http://www.smartcomputing.com
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the appropriate image. With the image now present in 
the slide, you can drag, crop, resize, and otherwise edit 
the image. To make a nice background, drag the image 
so that it fills the screen, right click it, and select Format 
Picture. When the dialog box appears, change the color 
scheme to washout and click OK. This will make the 
image look like more of a watermark over which you can 
add text. If the image is not satisfactory, repeat the pro-
cess from the right click on and change the brightness 
and contrast settings accordingly. Use your imagination 
to come up with more ways to create personalized, cus-
tom graphics for your PowerPoint presentations. 
 
 

Display Or Hide Toolbars 
As with most Microsoft programs, you can control which 
toolbars display onscreen in FrontPage. This ensures 
that the toolbars you need are handy and also pre-
serves screen real estate. By default, the Standard and 
Formatting toolbars display in FrontPage. To display 
another toolbar, click View and then Toolbars and select 
the toolbar you wish to use. For even faster access, 
right-click any visible toolbar (or the menu bar), and then 
click a toolbar's name on the displayed list. In the same 
way, you can hide a toolbar by right-clicking it and then 
clearing the check mark that appears next to its name 
on the list. 
 

Animate Menus 

You can animate the drop-down menus for FrontPage, 

Word, and Access. To do this, right-click any visible 

toolbar and then choose Customize from the shortcut 

menu. In the Customize dialog box, click the Options 

tab. Click the Menu Animations drop-down arrow and 

then choose an effect (such as Slide or Unfold) from the 

list. Click Close to confirm your choice and use the 

menu animations.  

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

Find Your Devices 
To find out what components are in your computer, right

-click the My Computer icon on the desktop. Click Prop-

erties, then click the General tab. This tells you what OS 

you are using, the processor speed, and amount of 

RAM in the computer. To view the actual devices, click 

the Hardware tab and then click the Device Manager. In 

the Device Manager you will see a list of every type of 

hardware in your computer. For example, if you click 

DVD/CD-ROM drives you will see each separate drive 

listed under that category. To see more information 

about any specific drive double-click it. This lets you see 

component info, such as the device status and if the 

device is enabled. You will also see what drivers the 

device is using and when they were last updated. 
 

open source  

Source code that is freely available to programmers for 

use in developing new software. The source is usually in 

the form of a standard--a sound format such as MP3, for 

example. It can also refer to an entire program (such as 

Netscape Communicator) or an operating system, such 

as Linux. Proponents of open source argue that by let-

ting as many developers as possible work on a pro-

gram, the software evolves. Developers will fix bugs, 

add new features, and adapt it for new uses or operat-

ing systems. See Open Source Initiative (OSI).  
 

Customize PowerPoint Graphics 
Inserting Clip Art into your PowerPoint presentation is 
great, but you can take presentation to the next level by 
adding your own graphics. All you need is a picture or 
graphics file (JPEG, GIF, etc.), such as a shot of the 
outside of your office building or your colleague giving a 
presentation at a conference. To insert an image into 
PowerPoint, navigate to the appointed slide and click 
Insert, Picture, and From File. Browse to find and select 
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MEMBERSHIP WITH LCCUG: 
 Yearly dues are $25 .  For more information, contact: 

 

Director of Membership, 

membership@lccug.com. 

 

Directions to Meetings: 
A map and directions to our meetings can be found on our 

Members’ web page www.lccug.com/members.  Just click 

on the link “Meeting Locations & Directions” 
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